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YAYIM KURALLARI

1. Amisos Dergisi, Ondokuz Mayis Universitesi Arkeoloji Béliimii Ogretim Uyelerinden
Dog. Dr. Davut Yigitpasa ve Dr. Ogr. Uyesi Akin Temiir tarafindan, yilda iki kez yayimlanan
ve tim konferanslarda  sunulan  tebliglerin  metinlerini,  bilimsel  yenilik getiren,
0zglin makalelerini ve kitap elestirilerini iceren Internet iizerinden yayimlanan uluslararasi
hakemli bir dergidir.

2. Yayimlamak Tlizere dergiye verilen yazilar, yazarin tercihine gore Tiirkge,
Almanca, Ingilizce, Rusca olabilir. Daha once baska bir yerde yaymlanmamis olmasi
gereken makaleler; Times New Roman, tek satir aralikli, 12 punto; sayfa sinirlamasi yoktur.
Bibliyografik referanslar metin igerisinde veya sayfa altinda verilebilir. Dipnotlar 10 punto
olarak verilmelidir. Ancak bazi alanlarin geregi olarak yazim esnasinda 6zel font kullanilmis
ise, bu fontlar makale ile birlikte gonderilmelidir.

3. Makalelere Ingilizce ve Tlrkge 200 kelimelik 6zet ve 5 anahtar kelime (Tirkce
ve Ingilizce olarak) eklenmelidir.

4. Makale icerisinde yer alacak fotograf, ¢izim ve haritalarin 20'yi asmamasina
6zen gosterilmelidir.

5. Fotograf ve ¢izimlerin agiklamalari, ayrica alintt olanlarin da kaynaklari belirtilerek
ayr1 bir sayfada gonderilmelidir.

6. Dijital formatta gonderilecek gorsel malzemenin ¢6zuniirliigii en az 300 pixel/inch, uzun
kenar1 en az 15 cm, tam sayfa kullanilacak bir fotograf ya da ¢izim s6z konusu ise en az 22
cm olmalidir.
7. Makale, PC ya da Macintosh ortamlarinda, Microsoft Word 2010 ve iizeri
versiyonlarda hazirlanmis olmali; PDF formatli bir 6rnegi ile birlikte derginin e-mail

adresine ulastirilmalidir (amisos.dergi@gmail.com).

Makalede sayfa diizeni su sekilde olmalidir:

Metin Dipnot | Paragraf | Paragraf | Ust Alt Sag Sol Satir

boyutu boyutu araligi girinti kenar kenar kenar kenar araligi
boslugu | boslugu | boslugu | boslugu

12 punto | 10 punto | 12 nk 1.25cm | 2,5¢cm 2,5¢cm 2,5¢cm 2,5¢cm Tek

8. Makale icerisindeki bibliyografik gdndermeler makale sonunda ve asagida

verilen orneklerdeki sitemde hazirlanmalidir;

Dincol, A. —Dincol, B. 1992, “Die Urartaeische Inschrift aus Hanak (Kars)”, H. Otten — E.
Akurgal — H. Ertem — A. Suel (eds.), Hittite and other Anatolian and Near Eastern Studies in
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Honour of Sedat Alp, Ankara: 109-117.

Karaosmanoglu, M. 2010 “Yeni Bulgular Isiginda Altintepe Urartu Tapiagi”, XV. Turk Tarih
Kongresi I, Ankara: 209-220.

Oniz, H. 2008 Arkeolojik Sualt: Arastirmaciligina  Girig Icin  Egitim Metodolojisi,
Yaymlanmamis Yiiksek Lisans Tezi, Selguk Universitesi, Sosyal Bilimler Enstitus,
Arkeoloji Anabilim Dali.

Temir, A. 2015, “Thoughts on a Grave Stele From The Classical Period in Samsun
Museum”, Belleten 286/LXXIX, 817-826.

Yakar, J.2003 “ldentifying Migrations in the Archaeological Records of Anatolia”,
B. Fischer — H. Genz — E. Jean — K. Koroglu (eds.), Identifying Changes: The Transition
from Bronze to Iron Ages in Anatolia and its Neighbouring Regions, Procceding of the
International Workshop Istanbul, Nowember 8-9, 2002, Istanbul: 11-19.

Yigitpasa, D. 2016, Dogu Anadolu Ge¢ Demir Cagi Kiiltiirii, Ankara.

Internet Kaynaklar1 agagidaki gibi verilmelidir:

URL 1 http://imgkid.com/tibial-fibular-notch.shtml

9. Bibliyografik referanslar dipnotta yazar soyadi, yayin tarihi ve gdnderme yapilan sayfa
olarak verilmelidir. Temtr 2015, 817; Yigitpasa 2016, 45.

10. Yilda Aralik ve Haziran olarak ¢ikan siireli yaymimiza verilecek makaleler, s6z konusu
donem icerisinden dnce editorlere teslim edilmelidir.

11. Dergiye gonderilen makale, yayima uygunluk agisindan incelendikten sonra (yayima
uygun gorilmeyen makaleler sirece dahil edilmez) iki hakeme gonderilir. Hakemlerin
degerlendirmeleri sonucunda iki yayimlanabilir raporu alan makale, dergi yonetimince uygun
goriilen bir sayida yayimlanir. Hakem raporlarinin birisinin olumlu, digerinin olumsuz
olmasi durumunda makale iiclincii bir hakeme gonderilir. Bu durumda makalenin yayimlanip
yayimlanmamasina ti¢lincii hakemin raporuna gore karar verilir. (Dergiye gelen makalelerin
yogunlugu sebebiyle degerlendirme ve yayim siiregleri farklilik arz edebilmektedir.)

12. Makaleler, hakemlere dogrudan sistem {izerinden (yazarin yiikledigi dosyada degisiklik
yapilmadan) yonlendirilmektedir. Makale iizerinde yazar-hakem gizliligini saglama adina

makalenin sahibini tanimlayici herhangi bir bilgi olmamalidir.

Makalelerde kullanilacak kisaltmalarda TDK yazim kilavuzu esas alinmalidir.
Bu ilkelere uymayan makaleler kesinlikle degerlendirilmeye alinmayacaktir. The Amisos
Journal / Amisos Dergisi, gonderilen makaleleri yayimlayip yayimlamama, gerekli gordiigi

durumlarda makaleler iizerinde diizeltmeler yapma hakkina sahiptir. Gonderilen yazilarin
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yayimmlanma hakki dergi yonetimine aittir. Dergide yayimlanmis bir yazinin hukuki
sorumlulugu ise yazarina aittir ve dergiyi ilgilendirmez. Dergide yayimlanan yazilar, dergi
yonetimin yazili izni olmadan higbir sekilde ¢ogaltilamaz ve baska bir yerde (matbu olarak
veya internet ortaminda) tekrar yayimlanamaz. Dergiye makale gonderen yazar, bu ilkeleri

kabul etmis sayilir.

MAKALELERIN GONDERILMESI

Yukaridaki ilkelere uygun olarak hazirlanmis makaleler, MAKALE GONDER SISTEMI
uzerinden gonderilmelidir. E-mail yoluyla gonderilen makaleler dikkate alinmamaktadir.
"MAKALE GONDER SISTEMI"nden makale géndermek igin:

* ULAKBIM/DergiPark’a iiye olduktan sonra, kullanici adi (sisteme kaydedilen e-mail

adresi) ve sifre ile sayfaya girilmelidir.
* Agilan sayfada "makale gonder" boliimii agilarak ilgili bosluklar doldurulmalidar.

* Makale word dosyasi halinde, yazar bilgileri olmadan sisteme yiiklenmelidir. Kor hakemlik
siirecinin daha saglikli yiiriitiilebilmesi i¢in yazarlarimizin bilgilerini paylasmamalarina

dikkat etmeleri gerekmektedir. Ayr1 bir word dosyasinda yazar bilgileri eklenebilir.
Yazar bagimsiz hakem degerlendirmesinin saglanmasi

Bagvurularin yazar bagimsiz degerlendirilmesi, yazar ve hakem kimliklerinin birbirlerine
bildirilmemesi icin gayret gosterilmektedir. Bu amagla sisteme dosya gonderen yazar, editor,

hakem gibi kisilerin metin ve dosyalar ile ilgili asagidaki noktalara dikkat etmeleri gereKir.

Yazarlar metinde adlar1 ve kurumlar1 gecen yerleri silmelidirler. Sayfa alt1 notlar1 vb yan
metinler dahil olmak iizere Mikrosoft belgeleri saklanir iken dosya bilgileri icine kisisel
bilgiler de yazilir. Bu nedenle ya bu kisisel bilgiler belge 6zelliklerinden bulunup silinmeli,
ya da asagidaki sira ile belge kisisel bilgi igermeyecek bigimde yeniden kaydedilmelidir.
(File > Save As > Tools (or Options with a Mac) > Security > Remove personal information
from file properties on save > Save) (Dosya > Farkli Kaydet > Araglar > Giivenlik > Kisisel
bilgileri silerek kaydet > Kaydet)

PDF dosyalarda da Adoba Acrobat ana meniisiinden belge Ozellikleri secilerek, yazar adi

silinmelidir.
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PUBLICATION INSTRUCTIONS

1. Amisos Journal is a journal containing two articles published twice a year, including texts
of papers presented at all conferences, scientific articles, original articles and book critiques
by Assoc. Prof. Dr. Davut Yigitpasa and Dr. Assist. Prof. Akin Temiir of the Department of
Archeology of the University of Ondokuz Mayis.

2. The manuscripts given for publishing can be in Turkish, German or English according to
the author's preference. Articles should not have been published elsewhere; Times New
Roman, single line spacing, 12 pt; there is no page limit. Bibliographic references can be
given in the text or at the bottom of the page. Footnotes should be given in 10 points.
3. The articles should include a summary of 200 words in English and Turkish and 5
keywords (in Turkish and English).

4. Care must be taken not to exceed 20 photographs, drawings and maps to be included in the
article.

5. Explanations of photographs and drawings should also be sent on a separate page,
specifying the sources of the quotations.

6. Resolution of visual material to be sent in digital format should have at least 300 pixels /
inch, a long edge at least 15 cm., a full-page photo or drawing, and a minimum of 22 cm.

7. The article should be prepared in Microsoft Word 2010 and above, in PC or Macintosh; It
should be sent to the e-mail address of the magazine along with a sample of the PDF format

(amisos.dergi@gmail.com).

The article page layout should be as follows:

Text Footnote | Paragraph | Paragraph | Top Bottom | Right Left Line
size size spacing indent margin | margin | margin | margin | spacing
12 10 12 nk 1.25cm 2,5¢cm 2,5¢cm 2,5cm 2,5cm Single
points points

8. Bibliographic referrals in the article should be prepared at the end of the article and in the
following examples:

Dincol, A. —Dincol, B. 1992, “Die Urartaeische Inschrift aus Hanak (Kars)”, H. Otten — E.
Akurgal — H. Ertem — A. Suel (eds.), Hittite and other Anatolian and Near Eastern Studies in
Honour of Sedat Alp, Ankara: 109-117.

Karaosmanoglu, M. 2010, “Yeni Bulgular Isiginda Altintepe Urartu Tapinagi”, XV. Turk
Tarih Kongresi |, Ankara: 209-220.

Oniz, H. 2008 Arkeolojik Sualti Arastrmaciligina  Girig Icin  Egitim Metodolojisi,
Yayinlanmamis Yiiksek Lisans Tezi, Selcuk Universitesi, Sosyal Bilimler Enstitisu,
Arkeoloji Anabilim Dalu.
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Temir, A. 2015, “Thoughts on a Grave Stele From The Classical Period in Samsun
Museum”, Belleten 286/LXXIX: 817-826.

Yakar, J.2003, “ldentifying Migrations in the Archaeological Records of Anatolia”,
B. Fischer — H. Genz — E. Jean — K. Koroglu (eds.), Identifying Changes: The Transition
from Bronze to Iron Ages in Anatolia and its Neighbouring Regions, Procceding of the
International Workshop Istanbul, Nowember 8-9, 2002, Istanbul: 11-19.

Yigitpasa, D. 2016, Dogu Anadolu Ge¢ Demir Cagi Kiiltiirii, Ankara.

Internet Kaynaklar1 agagidaki gibi verilmelidir:

URL 1 http://imgkid.com/tibial-fibular-notch.shtml

9. Bibliographic references should be given footnote author surname, publication date, and
referenced page. Temur 2015, 817; Yigitpasa 2016, 45.

10. Avrticles to be given periodicals published in December and June in the year must be
submitted to the editors before the said period.

11. The submitted article has been sent for publication appropriateness (articles not found
appropriate for publication are not included in the process) will be sent to two referees after
reviewing. As a result of the evaluations of the referees, the article which received two
publishable reports is published in a number deemed suitable for the management of the
journal. If one of the referee reports is positive and the other is negative, the article will be
sent a third referee. In this case, the publication of the article should be decided according to
the third referee report. (Evaluation and publication processes may vary due to the intensity
of the articles coming from the journal.)

12. The articles are directed to the referees directly through the system (without any changes
to the file the author uploads). There should not be any descriptive information on the article
in order to provide author-referee privacy.

Abbreviations to be used in the articles should be based on the TDK writing guide.

Articles that do not comply with these principles will not be taken into consideration. The
Amisos Journal reserves the right to publish and not to publish the submitted articles, and to
make corrections to the articles when it deems necessary. The right to publish of the
manuscripts belongs to the journal management. The juridical responsibility of a published
article in the journals belongs to the author and does not concern the journals. Articles
published in the journal can not be reproduced in any way without the written consent of the
journal management and can not be reproduced elsewhere (in print or on the internet). The

author who submits articles to the journal is considered to have accepted these principles.
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SUBMITTED ARTICLES
Articles prepared in accordance with the above principles should be sent via the
SUBMISSION SENDING SYSTEM. Articles submitted via e-mail are not considered. To
submit an article from the * SUBMISSION SENDING SYSTEM":
* After subscribing to ULAKBIM/DergiPark, you should enter the page with

username (e-mail address saved in system) and password.

* In the opening page, the "send article™ section should be opened and the related
spaces should be filled in.

* The article should be loaded into the system as a word file. In order for the blind
arbitration process to be carried out better, the authors should be careful not to share their

knowledge. Author information can be added in a separate word file.

Author independent peer review

Independent evaluation of the applications of the author, authors and referees are not being
reported to each other. For this purpose, people who send files to the system, such as authors,
editors, referees should pay attention to the following points about text and files.

Authors should delete names and institutions in the text. The page information is also written
into personal information while the page is stored in the Microsoft documents including sub-
texts etc. Side texts. Therefore, either these personal information must be found and deleted
from the document properties, or the document in the following order should be re-recorded
so that it does not contain any personal information. (File> Save As> Tools> Security>

Delete Personal Information> Save)

In PDF files, the author name should be deleted by selecting document properties from the

Acrobat main menu.



